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Chapter 1: Getting Started 
 

System Requirements 
To get the most out of your fees processing system, you will need the following 

1. An IBM compatible Personal Computer 
2. Microsoft Windows 95, 98, 2000 (SP3), ME, or XP 
3. At least 32MB of RAM for Windows 95 
4. At a Pentium 90MHz processor. 
5. A printer capable of printing onto A4 paper. 
6. CDROM Drive for the printer 
7. The hard disk space is best determined on a case-by-case basis due to the 

variations in databases. 
For ease in exporting data, it is recommended that you have Microsoft® Excel 95 or 
better or any other spreadsheet that can read the Excel 95 format.  

What the CD Includes 
The installation CD includes the following 

1. An installation program for the system. 
2. The System Development Manual (MS Word 2000 and PDF formats) 
3. The User Manual (MS Word 2000 and PDF format) 
4. Windows 2000 Service Pack 3. 
5. Adobe Acrobat Reader 5.0 
6. Microsoft Word Viewer for Word 97/2000 
7. System Source Code (Visual Basic 6.0) 

Installing The System 
In the following section, it is assumed that your CD-ROM is on drive D. If this is not 
the case then substitute you CD-ROM drive letter in the appropriate places. Please 
note that if you are installing on a Windows 2000 machine, you must first install 
Windows 2000 Service Pack 3. The installation file for WSP3 is included on the CD-
ROM under D:\W2KSP3 
 

 

Do not install the service pack unless you are absolutely sure that your 
machine does not already have WSP3 or any other later version of the 
Windows Service Pack. Also, the Service Pack is meant for Windows 
2000 only. Installing it on any other operating system will cause 
unpredictable results with the worst-case scenario of a total loss of ALL 
the data on your computer. 

 
 
To install the Levy Processing System, 

1. Close any applications that you maybe running 
2. Insert the CD into your CD-ROM drive 
3. Run D:\Setup.exe you will be presented with the following screen 
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4. Choose the OK button. You will be presented with the following screen 
 

 
5. Enter the password you would like to use for you administrative account. You 

must enter it in the Password and Re-enter Password boxes. 
 

 

This password will give you unrestricted control over the system when 
you log in with the username “admin”. It is therefore important that the 
person who is in charge of the levy office be the only one who knows 
this password.  

 

 

Password can be forgotten or the person who knows the password can 
become incapacitated. You may therefore want to consider keeping a 
copy of the password in a sealed envelope in the school safe or other 
secure place with clear guidelines of the circumstances under which the 
envelope can be opened. 
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6. Enter the location of your database by clicking on the Database Path box and 

then entering the filename in the window that appears. Note that this filename 
must not be the same as that of any other file on your system. 

7. Start the installation by clicking on the button with the computer on it. 

 
 

8. Follow the onscreen instructions. If the installation is successful, you will be 
presented with the following message 

 
 

Logging Into The System 
To ensure that only those who are authorised to use the system are the ones who gain 
access to it, the Levy Processing System requires everyone to log on. When you start 
any of the system components, you will be presented with the following screen 

 
To log on, 

1. Enter your username. To log in as an administrator you must use the username 
“Admin”. The administrator allocates user names and passwords. 

2. Enter your password. 
3. Click on the Log In button. 

The structure of the Levy System 
The levy system comprises 4 components. Each of the components is accessible from 
the Levy Office System program group. The components in summary are as follows 
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Components Remarks 
Administrative 
Console 

• Used to configure the system.  
• Can only be used by the administrator. 
• Explained in Chapter 2. 

Advanced Search • Used to execute SQL  
• Explained in Chapter 4 

Mail Merge • Used for automatic mailings 
• Explained in Chapter 8 

Levy Office System • Forms the bulk of the system 
• Handles students records along with the associated 

accounts 
 

Getting Assistance While You Work 
All the windows that you are presented with within the system have online help 
support. You can get a quick summary of how to use the window by either 
¾ Clicking on the Help button. 
¾ Choosing Help from the menu if the window has one 
¾ Or pressing the F1 key. 

Also, most buttons and input boxes will give you a quick summary of what they do if 
you place the mouse over them for a few seconds. 
 
Although the online system is handy, it is advisable that you skim through the entire 
user manual (Available on the CD) before trying anything out. You are also free to 
print out the manual. 
 
If you are stuck or discover a bug within the system, you can get assistance by 
contacting the system developer at tgmotsi@yahoo.com. You may also want to have a 
look at the Levy System website at www.geocities.com/tgmotsi which will contain 
updates for the system. 
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Chapter 2: Configuring The System 
 
System configuration is handled through the Administrative Console that is available 
in the system’s Windows Program group. This utility is only accessible to the 
administrator who must log in using the username “admin”. After logging in you will 
be presented with the following window 
 

 
 

Database Issues 
The installation program will attempt to configure a database for you but for various 
operating system related problems, this may fail. If this happens then you must 
manually configure the system database before you can use the system. You have 
various options with regards to how you go about this and these are detailed below. 

Installing The Sample Database 
To assist you in learning the system, the Levy Processing System comes with a 
sample database that you can play around with until you are confident enough to start 
using system within your school. To install this sample database 
 

1. Choose Install Sample Database from the Administrative Console’s Admin 
menu. You will be presented with the following window. 

 
 

2. Click the white box labelled Database Location and you will be presented with 
an ordinary Save As dialogue box.  
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3. Specify the filename that must not be the filename of a file that already exist. 
4. Choose Save. You will be returned to above shown window. 
5. Click the Install Database button. If the sample database is installed 

successfully, you will get a message to that effect. 
 

Installing A Blank Database 
After you have tried out the sample database, you can then install a blank database 
into which you can enter the data that exists within your school environment. The 
steps for doing this are as follows 

1. Choose Install Blank Database from the Administrative Console’s Admin 
menu.  

2. Click the white box labelled Database Location and you will be presented with 
an ordinary Save As dialogue box.  

3. Specify the filename that must not be the filename of a file that already exist. 
4. Choose Save. You will be returned to above shown window. 
5. Click the Install Database button. If the sample database is installed 

successfully, you will get a message to that effect. 
 

Resetting The Database Path 
At some point in time, you may find that you will need to get the system to install a 
database that already exists on your system. For example, you may install a new copy 
of the system but still want to use your old database. To do this 

1. Choose Reset Database Path from the Administrative Console’s Admin 
menu. You will be presented with an ordinary Save As dialogue box.  

2. Specify the filename that must not be the filename of a file that already exist. 
3. Choose Save. If the database is installed successfully, you will get a message 

to that effect. 

Optimising Your Database 
Over time, your database will cease to be organised in an efficient way. When such a 
situation arises, the database will begin to grow and occupy more space than it should. 
The Levy System comes with a facility that allows you to reorganise the database and 
compact it. To access this facility, you should choose Repair/Optimise Database from 
the Admin menu of the Administrative Console. 

Repairing Your Database 
It is likely that sooner or later you will run into an eventuality that will damage your 
database. This could arise from anything ranging from a power cut to a hardware 
failure. As such you should implement a reasonable backup policy to safeguard your 
data. In the event of the database becoming corrupt, you can ask the Levy System’s 
Administrative Console to attempt to repair the database. To do this, choose 
Repair/Optimise Database from the Administrative Console’s Admin menu. It is 
however unlikely that the database will be fully recovered and as such you should 
depend more on your backups.  

Controlling Access 
The Levy System has been designed with security in mind. One of the ways in which 
it protects the system is by maintaining a list of users who can log into the system 
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with only the permissions to do that which they have been allowed to do. The security 
policy is managed using the User Management facility in the Administrative Console. 
To start the User Management tool, choose Manage User Accounts from the 
Administrative Console’s Admin menu. All of the procedures detailed below are 
based on the assumption that you will already be in the User Management Tool that is 
shown below. 

 

Setting Up User Accounts 
This will be your first step towards a security policy. A user account is a definition of 
a user with regards to 
¾ The name they use to log on (User Name) 
¾ Password 
¾ What they are allowed to do. 

 
To create a new user, 

1. Choose Create New Account from the User Management Tool’s Tools menu. 
You will be presented with the following window. 

 

 
 

2. Enter the name you will want the user to use log into the system in the User 
Name box. This name can be up to 30 characters long and include spaces 
though you will probably want to keep it short. It must also be unique. Once 
assigned, a username can only be deleted, it cannot be changed in any other 
way. 
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3. Enter the password for the user in the two password boxes. The user will be 
able to change this password when they log in. 

4. Click the Create button. 
5. The username will be created and added to the list of user names displayed in 

the User Management Tool. 
 

Changing User Access Rights 
When you create a user account, the user of that account will only be allowed to look 
at the information in the database. They will not be in a position to change it in any 
way. To allow the user to carry out operations that will modify the contents of your 
database, 

1. Select the user’s username in the User Management Tool. 
2. Select Change User Rights from the User Management Tool’s Tools menu. 

You will be presented with the following window 

 
 

3. Go through each tab and mark the services that you would want the particular 
user to have access to.  

4. When you are through choose Save. 
 

Deleting A User Account 
At some point in time you may decide that a particular user should no longer have 
access to the system. To implement this decision, you must delete the user account. 
To do this, 

1. Select the user’s User Name from the list of user in the User Management 
Tool 

2. Select Delete Account from the Tools menu of the User Management Tool. 
3. You will be prompted to confirm the account deletion. Choose ‘Yes’ to delete 

the account. 
 

Changing A User’s Password 
Any user can change his or her password from any of the components of the Levy 
system. To do this, 
1. Log into one of the components of the Levy System 
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2. Select Change Password from the first in the component’s main window. You 
will be presented with the following window. 

 
3. Enter your current password in the space provided. 
4. Enter the new password you wish to use.  
5. Re-enter the new password in the space provided 
6. Choose the Save button. 
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Chapter 3: Students Records 
 
Students’ records comprise classes, registered students and deregistered students. The 
facilities for managing these are available from the Students menu of the Levy 
Management System. 

 

Managing Classes 
Before you can register new students you must have some classes registered. Once 
registered, you can view, edit and delete any given class from your list of classes. 
Note however that you cannot deregister a class if it still has some students in it. To 
access class management facilities, select Classes from the Students menu. You will 
be presented with the following window. 

 
 
To browse through the classes, 

1. Choose the Next button to view the class that occurs after the currently 
displayed class. If the class you are viewing is the last, you will be given an 
option to jump to the first class. 

2. Choose the Previous button to view the class that occurs before the currently 
displayed class. If the class you are viewing is the first, you will be given an 
option to jump to the last class. 

3. To jump to the last record, select Jump To Last from the Services menu of 
the Class Management window. 

4. To jump to the first record, select Jump To First from the Services menu of 
the Class Management window. 

5. Choose the Close button to close the Class Management window 
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To register a new class, 

1. Select New from the Services menu. Your window will change to the one 
shown below 

 
 

2. Enter the class, which can be up to 6 characters long and must not be the name 
of an existing class. 

3. Enter the name of the class’ form teacher. This can be up to 50 characters long 
and different classes may share a form teacher. 

4. Enter the minimum balance, which should be greater than $0. The box for 
entering this is divided into two. The one to the left is for the dollars whilst the 
one to the right is for the cents. You do not need to enter a dollars/cents 
separator in between. 

5. Choose the Save button.  
 
After registering a class, you will not be allowed to change its name. You may 
however change the Minimum Balance of the caution deposit account and the name 
of the form teacher. To do this, 

1. Browse to the class whose details you want to change. 
2. Select Edit from the Services menu. 
3. Change either the form teacher’s name or the minimum balance on the caution 

deposit account for the class. You cannot change the class’ name. 
4. Choose Save 

 
At some point you may decide to delete a class that is no longer in use. To do this 

1. Browse to the class you want to delete. 
2. Select Delete from the Services menu 
3. You will be prompted to confirm the deletion. Choose Yes to delete the class. 
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Registered Students 
After registering some classes, you can then move onto record the details of students 
within your school. Facilities for managing registered students are provided from the 
Registered Students window. To access this window, select Registered Students 
from the Students menu. You will be presented with the following window 
 

 
 
To browse through the students records, 
¾ Choose the Next button to view the student record that occurs after the 

currently displayed student record. If the record you are viewing is the last 
one, you will be given an option to jump to the first student record. 

¾ Choose the Previous button to view the student record that occurs after the 
currently displayed student record. If the record you are viewing is the first 
one, you will be given an option to jump to the last student record. 

¾ To jump to the last record, select Jump To Last from the Services menu of 
the Class Management window. 

¾ To jump to the first record, select Jump To First from the Services menu of 
the Class Management window. 

¾ To jump to the record of a specific student, select Jump to Record from the 
Services menu and then enter the Student ID of the student to whose record 
you want to jump. 

¾ Choose the Close button to close the Class Management window 
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To register a new student, 
1. Select New from the Services menu. Your window will change to the one 

shown below. The student ID will be automatically generated for you. Please 
note it down. 

 
 

2. Enter the student’s surname, which can be up to 20 characters. 
3. Enter the First Names, which can be up to 30 characters in combined length 

including any spaces separating them. 
4. Select the sex of the student from the list provided. 
5. Select the class of the student from the list provided. If the class you want is 

not in the list then register the class by following the instruction under Class 
Management. 

6. Enter the Guardian’s details comprising  
a. A title which can be up to 6 characters long e.g. Prof 
b. The initials, which can be up to 6 characters long e.g. J.K. 
c. The surname, which can be up to 20 characters long. 
d. The postal address for use in mailings, which can be up to 150 

characters long and include more than one line. To start a new line in 
the address, press the Enter key. 

e. A phone number, which can be up to 20 characters long. And include 
non-digit characters like (, c and -. 

7. Choose the Save button. 
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Once a student is registered you can change all of his/her details save for the Student 
ID by doing the following 

1. Browse to the record of the student whose details you want to change. 
2. Select Edit from the Services menu. 
3. Change the details you want to change. 
4. Choose Save 

 
A student once registered becomes a permanent member of the system i.e. you cannot 
delete student records. You can however deregister a student, which is a way of 
telling the system that the student is no longer learning at the school. For a student to 
be deregistered he/she must have a balance of $0.00 in both his/her Levy Fees and 
Caution Deposit Accounts. If the student record satisfies the above condition, you can 
proceed to deregister the student by doing the following 

1. Browse to the record of the student you want to deregister. 
2. Select Deregister from the Services menu. 
3. You will be prompted to confirm the Deregistration. Choose ‘Yes’ to 

deregister the student 
4. If the student’s fees accounts are no longer active, he/she will be deregistered 

and you will be given a confirmation message to that effect. 
Once deregistered, you can access the former student’s record and reregister him/her 
through the Deregistered Students window as explained below. 
 

Deregistered Students 
The records of deregistered students cannot be edited in any way. Basically, all you 
can do is look at the records and reregister students who rejoin the school. The 
browsing techniques outlined under Registered Students also apply to this window.  
 
To reregister a student, 

1. Browse to his/her record. 
2. Choose Reregister from the Services menu. 
3. You will be prompted to confirm the re-registration. Choose ‘Yes’ to 

reregister the student 
4. You will be prompted to enter the class the student will be joining. You make 

this selection using the following window 
 

 
 

5. Select the class from the list provided. 
6. If the student is successfully re-registered, you will be given a message to that 

effect. 
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Batch Updating Classes 
At the end of the year, you will probably need to move all the students in one class 
e.g. 1A1 to another e.g. 2A1. Instead of going to each record and manually updating 
the class of each student, you may find the Batch Update Classes function useful. To 
access it, choose Batch Update Classes from the Students menu. On doing this you 
will be presented with the following window. 

 
 
To batch update the classes, 

1. Select the class from which you would like to move the students from the 
Current Class list. 

2. Select the class to which you want to move the students from the New Class 
list. 

3. Choose the Update button. 
 
 
 

 

You may find the following strategy useful when doing your batch 
updates 

1. Create a class for all the outgoing Form 4’s e.g. F4 LV 
2. Create a class for all the outgoing Upper Six Students e.g. U6 

LV 
3. Move the students in all the form 4 classes to F4 LV 
4. Move the students in all the Upper Six classes to U6 LV 
5. Start moving the rest of the student starting with the most 

seniors e.g. starting with L6 Sc to U6 Sc and ending with F1A1 
to F2A2 
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Chapter 4: Finding Information 
 
The levy system provides you with two facilities for looking up the information stored 
in your database. The first is pretty straightforward and is built around the Search 
utility. The Search utility is simple and probably adequate for most of your needs. 
However, once in a while you will probably want to burrow to the heart of your 
database to get some information that is not available in the utilities provided within 
the Levy System. To do this you must use the Advanced Search utility, which is 
however a bit more complex as it requires knowledge of the Standard Query 
Language. The two utilities are outlined below in detail. 
 

The Search Utility 
The search utility is accessible from the Students menu of the Levy System when you 
choose Search. Also, unlike most f the windows in the system, you can keep it open 
whilst working on something else. The search window is shown in the diagram below: 
 

 
 

To run a search, 
1. Select the search item from the list provided. The list provides the following 

search items. 
¾ Student ID 
¾ Student’s Surname 
¾ Student’s First Names 
¾ Student’s Class 
¾ Student’s Guardian’s Surname 

2. Enter the search item, which can include pattern-matching characters as to the 
guidelines in the following section. 

3. Choose the Search Button. You will be presented with the following results 
window. 
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4. Apart from looking at the results, you can do any of the following by selecting the 
corresponding function from the Tools menu of the Results Window. 

¾ Export the Source SQL for use in Advanced Search or Mail Merge 
¾ Export the results to a Microsoft Excel spreadsheet. 
¾ Export the results to a generic spreadsheet format 
¾ Print the results 

 
 

 

When you export the information you will get extra information like full 
Guardian details. This is particularly useful for Mail Merge operations. 
Try it out! 

 

The Advanced Search Utility 
The Advanced Search Utility, shown in the diagram below, allows you to execute 
queries on the database for as long as those queries do not seek to modify data. This 
utility will allow you to find any information you may want from the database 
provided you know the SQL required for the query. For the database table structure, 
consult the section below. 
 
 The dialect of SQL that is used in the Levy System is the same as the one that is used 
in Microsoft® Access and as such any Access User or Developer’s manual will more 
than adequately cover the subject. A set of sample queries has been provided for you 
in the SQL subfolder of the Levy System and you can modify these if you need to. 
You can also generate SQL by exporting the source SQL generated by the following 
facilities within the library system 
¾ Search 
¾ Deposit Balance Analysis 
¾ Levy Balance Analysis 
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The main search window, pictured above, allows you to manage your SQL files by 
saving and opening them later. The following is a summary of what the functions 
provided under the Tools menu of the main window do. 
 
Menu Item Remarks 
New Query Erases the query window allowing you to start working on a new 

query. 
Open SQL File Opens a previously saved SQL file.  
Save SQL File  Saves the currently displayed SQL file under its current filename 

if it already has one. 
Save SQL File As Saves the displayed SQL file under a different filename. 
Execute Query Presents the search results for the displayed query. 
Print SQL Prints the displayed SQL file text. 
 

Viewing Query Results 
After entering your SQL or opening a predefined query, you can view the results it 
returns by choosing Execute SQL from the Tools menu. If the query finds any 
matches you will be presented with the following results window 

 
 
From the above show results window, you can do the following by choosing the 
appropriate function from the Tools menu. 
¾ Adjust column widths so that they display the full details. 
¾ Export the results to Microsoft® Excel 
¾ Export the results to a generic format understood by all spread sheets  
¾ Adjust the row height. For example you can instruct the system to display 4 

lines of text for each record so that you can view the addresses clearly. 
 

 

Addresses do not export well to the generic format. You will probably 
get a better result if you export to the Excel Format and then try to 
import the results from the excel file into your spreadsheet program. 
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Using Pattern Matching In Your Searches 
You use wildcard characters as placeholders for other characters when you are 
specifying a value you want to find and you:  
¾ Know only part of the value. 
¾ Want to find values that start with a specific letter or match a certain pattern.  

In the Search and Advanced Search utility you can use the following characters to 
find such field value. 

Character Usage Example 

* Matches any number of characters. 
It can be used as the first or last 
character in the character string. 

wh* finds what, white, and 
why 

? Matches any single alphabetic 
character. 

B?ll finds ball, bell, and bill 

[ ] Matches any single character 
within the brackets. 

B[ae]ll finds ball and bell but 
not bill 

! Matches any character not in the 
brackets. 

b[!ae]ll finds bill and bull but 
not bell 

- Matches any one of a range of 
characters. You must specify the 
range in ascending order (A to Z, 
not Z to A). 

b[a-c]d finds bad, bbd, and 
bcd 

# Matches any single numeric 
character. 

1#3 finds 103, 113, 123 

 
Notes    
¾ Wildcard characters are meant to be used with text data types, although you 

can sometimes use them successfully with other data types, such as dates, if 
you don't change the Regional Settings properties for these data types. 

 

¾ When using wildcard characters to search for an asterisk (*), question mark 
(?), number sign (#), opening bracket ([), or hyphen (-), you must enclose the 
item you're searching for in brackets. For example, to search for a question 
mark, type [?]. If you're searching for a hyphen and other characters 
simultaneously, place the hyphen before or after all the other characters inside 
the brackets. (However, if you have an exclamation point (!) after the opening 
bracket, place the hyphen after the exclamation point.) If you're searching for 
an exclamation point (!) or closing bracket (]), you don't need to enclose it in 
brackets. 

¾ You can't search for the opening and closing brackets ([ ]) together because 
the Microsoft® Jet query system interprets this combination as a zero-length 
string. You must enclose the opening and closing brackets in brackets ([[ ]]). 
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Levy System Database Structure 

Table Structure 
1. Students 

(Student ID, Surname, First Names, Sex, Guardian Title, Guardian Surname,  
 Guardian Initials, Guardian Address, Class) 
 

2. Deregistered Students 
(Student ID, Surname, First Names, Date Deregistered, Guardian Title,  
Guardian Surname, Guardian Initials, Guardian Address) 
 

3. Classes 
(Class, Form Teacher, Minimum Balance) 
 

4. Registered Fees 
(Fee code, Fee Name) 
 

5. Levy Account Debits 
(Transaction Date, Amount, Fee Code, Student ID) 
 

6. Levy Account Credits 
(Transaction Date, Amount, Receipt Number, Student ID) 
 

7. Caution Fee Account Debits 
(Transaction Date, Reason, Amount, Reference Code, Student ID) 
 

8. Caution Fee Account Credits 
(Transaction Date, Amount, Receipt Number, Student ID) 
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Data Modelling Dictionary 
Field Name Type Remarks 
Amount Currency  
Class Text – 6cc Unique class name. 
Date Deregistered Time Contains both date and time information. 
Fee Code Integer Indexes fee table. Generated by system.  
Fee Name Text – 30cc Official title of a Levy Office fee as given on the 

approving circular. 
First Names Text – 30cc  
Form Teacher Text – 50cc Full name of the teacher who maintains the class list 

for the given class. 
Guardian’s Address Text – 150cc The contact address of the guardian. May contain 

several lines of text. 
Guardian’s Initials Text – 6cc The guardian’s initials as the should be printed e.g. 

J.K. 
Guardian’s 
Surname 

Text – 15cc  

Guardian’s 
Telephone Number 

Text – 20cc  

Guardian’s Title Text – 6cc The guardian’s official title e.g. Prof 
Minimum Balance Currency Class’ minimum balance for the Caution Fee Deposit 

Account. 
Reason Text – 30cc Brief description of reason for debit. 

e.g. Lost text book 
Receipt Number Text – 15cc  
Reference Code Text – 15cc Reference code of letter from disciplinary committee 

authorising debit. 
Sex Text – 1cc Stores the sex of the given student in the following 

format [F | M] 
F – Female; M – Male  

Student ID Text – 8cc  Unique student identification code structured as 
follows. 

Surname Text – 20cc   
Transaction Date Time Contains time when transaction was transacted. 

Includes date information. 
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Chapter 5: Managing Levy Fees 
 
Facilities for managing the levy fees are provided from the Levy Fees menu of the 
Levy System shown below. 

 
 

Registered fees 

Adding A New Fee 
Before you can use any fees, you must register them. To do this, 
1. Choose Registered Fees from the menu shown above. You will be presented with 

the following window. 

 
 

2. Select the “New Fee” button . You will be presented with following window 
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3. Enter the official title of the fee in the space provided and then choose the OK 
button. Note that this name must be unique i.e. there must not be an existing fee 
with the same name. If the above is successful, you will be returned to the main 
window, which will now have the just added fee in its list. 

Removing A Fee 
With time, you may come to no longer need a particular fee. In such a case you may 
find it worthwhile to delete such a fee so as to minimise clutter within your system. 
Note however that you can only delete a fee that is not in use by any student account 
or template. If you attempt to delete a fee that will be in use, the system will deny 
your request. To delete a fee 

1. Select it from the list of fees in the Registered Fee window. 
2. Choose the Delete Button, which is the one with the bin on it. 
3. You will be prompted to confirm the deletion, choose “Yes” to delete the fee 

from the registry of fees. 
 

Fees Templates 
During your debiting of accounts, you may find yourself entering the same list of fees 
each time. A typical scenario would be when you are registering form one or Lower 
Six students. To aid you within this respect, the Levy System comes with support for 
fees templates. A fees template is basically a list of registered fees and their 
associated amounts that you can call up within one operation. Your understanding of 
this may improve after you have had a look at the Debiting of accounts in the section 
below. Facilities for managing fees templates are provided from the Templates 
Management window, shown below, that you can access by selecting Fees Templates 
from the Levies menu of the Levy System. 
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Creating A New Template 
1. Select the New Template icon (see diagram above) 
2. You will be prompted for the name of the template by a window like the one 

shown below. Enter the name in the space provided. 

 
3. Choose the OK Button 
 
Note that the new template’s name must be unique and that it can be up to 30 
characters long. 
 

Deleting A Template 
1. Select its name from the list of templates 
2. Choose the Delete Template icon. 
 

Inserting A Fee Into A Template 
1. Select the template from the list provided you will be presented with the 

following window  

 
2. Select the fee name from the list provided 
3. Enter the amount by inserting the dollars part into the box to the left and the 

cents part into the box to the right. There is no need to enter a separator. 
4. Select the Insert Fee button 

 

Deleting A Fee From A Template 
1. Select the template from the list provided by clicking on it. 
2. Select the fee you wish to delete by also clicking on it. 
3. Click the Delete Fee icon 
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Charging Fees 
This facility is accessible by selecting Charge Fees from the Levies menu of the Levy 
System. The window provided by the facility is shown below. 
 

 
 
 
To perform a debit, do the following 
1. Decide on the debit target(s). This can either be an individual student or a an 

entire class of students. 
¾ To have an individual student as the debit target,  

a. Select the Individual Charge Option shown in the diagram above 
b. Enter the Student’s ID in the spaces provided. 

¾ To have a class as the debit target 
a. Select the Batch Charge Option 
b. Select the class from the list provided 
c. Have a look at the students who will be charged by clicking the 

Preview Targets button and verifying that the list is the same as that 
provided by the class register. 

2. Enter the fees you wish to charge by selecting one or a combination of the 
following methods 
¾ Loading a template  

a. Click the Load Template icon. You will be presented with a list of the 
available templates in a window like the one shown below. 
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b. Select one of the templates by clicking on it. 
c. Select the Load Button by clicking on it. To close the window without 

loading a template, choose the Cancel Button. 
¾ Entering a specific fee 

a. Click the Insert Fee icon. You will be presented with the following 
window. 

 
b. Select the fee from the List provided 
c. Enter the amount. 
d. Choose Insert Fee to insert the fee or Cancel to close the window 

without inserting a fee. Note that you can repeat this process to enter 
more individual fees. 

¾ Removing a fee from the list 
a. Select the fee you want to remove from the list of fees. 
b. Click the Remove Fee icon. 

¾ Removing all the listed fees at once 
a. Select the Clear Fees button 

3. Select the Charge button.  
 

Recording Payments 
Facilities for crediting accounts are provided through the Record Payment window 
shown below. To access this window, select Record Payment from the Levies 
window. 

 
 

To record a Levy payment, 
1. Enter the Student ID of the student concerned. 
2. Enter the receipt number issued to the student in the space provided. 
3. Enter the amount with the dollars part going into the left box and the cents part 

into the right part. Note that there is no need to enter a separator (.) in between the 
two. 

4. Select the Credit button. 
5. You will be prompted to confirm the credit. Choose ‘Yes’ to credit the account.  
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Individual Statements of Account 
You can view an individual student’s statement of account by using the window 
shown below. To access this window, choose Individual Statement of Account from 
the Levies menu. You will then be presented with the following window. 

 
 
To load an account, 

1. Click the Load button. You will be presented with the following window. 

 
2. Enter the Student ID in the space provided. 
3. Enter the date from which you want details of the statement by selecting from 

the calendar that you will be presented with when you click the arrow on the 
Start Date list. 

4. Enter the last date of the statement. 
5. Choose the Load button. 

 
Once the statement is loaded, you can export and print it by choosing any of the 
functions listed under the Tools menu. To view the statement of another student, 
select the Load button again. 

Batch Producing Statements of Accounts 
In your statement production, you will come across times when you will need to print 
a whole batch of statements of accounts in one go. A typical application area of this is 
at the end of each term. To avoid the cumbersome task of loading each statement and 
printing it in turn, the levy system provided you with a convenient facility for 
producing an entire batch of statements of accounts in one go. This facility if provided 
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from the window shown below that you can access by choosing Batch Print 
Statements of Accounts from the Levies menu. 

 
 
To print an entire batch of statements of accounts, 

1. Select the start date for each statement. 
2. Select the end date of each statement 
3. Specify the balance types you would like to print. For example, if you only 

want to send statements to those who are in arrears, select the “Accrued” 
option. 

4. Select the classes for which you would like to generate the statements. To do 
this, select the class you want to move from one of the lists to the other and 
then press the arrow with the same direction as the intended move. The arrows 
with the As above them move all the items from one of the lists to the other. 

5. Select Print. 
 

 

Clicking the print button more than once will result in the Levy System 
printing multiple copies of each statement. Therefore, if your machine is 
a bit slow and the system appears not be responding, give it about 10 
seconds before clicking the button again. 
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Chapter 6: Managing Deposit Accounts 
 

Managing An Individual Account 
Facilities for managing deposit accounts are provided via the Deposits menu in the 
Levy Office window shown below. 

 
Save for the batch printing of deposit statements of accounts outlined below, all 
deposit account management tasks must start with the loading of a student’s deposit 
account. Once an account has been loaded, you can proceed to debit, credit or 
generate a statement of account for the loaded account. The primary window for all 
these is shown below and is accessible by choosing Manage Individual Account 
from the menu shown above. 

 
 
 

Loading An Account 
1. Choose the Load button. You will be presented with a window asking for the 

Student ID of the student whose account you will want to load. 
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2. Enter the Student ID in the space provided and then select the OK button 
3. The account will then be loaded and the function for debiting, crediting and 

generating a statement of account for that given account will then become 
available from the Tools menu of the Account window. To load a different 
account, choose the Load button. 

Debiting An Account 
1. If the account is not already loaded, load it. 
2. Select Debit Account from the Tools menu. You will be presented with the 

following window. 

 
 
3. Enter the reference code of the letter authorising the debit in the Reference box. 

This can be up to 15 characters. 
4. Enter the amount to be debited in the Amount box noting that the dollars part goes 

into the left box and the cents go into the right box. There is no need for a 
separator in between. 

5. Enter a short description of the case responsible for the debit in the Reason box. 
This can be up to 30 characters. 

6. Select the Debit button to process the debit. 
 

Crediting An Account 
1. If the account is not already loaded, load it. 
2. Select Credit Account from the Tools menu. You will be presented with the 

following window. 
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3. Enter the receipt number of receipt issued with respect to the payment in the 

Receipt Number box. This can be up to 15 characters.  
4. Enter the amount to be credited in the Amount box noting that the dollars part 

goes into the left box and the cents go into the right box. There is no need for a 
separator in between. 

5. Choose the Credit button. 
 

Generating A Statement of Account 
1. If the account is not already loaded, load it. 
2. Select Statement of Account from the Tools menu. You will be presented with 

the following window. 

 
3. Select the start and end dates of the statement of account from the lists provided 

and click the Load button. You will then be presented with the statement in a 
window like the one shown below. 
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4. You can then proceed to print or export the statement of account by choosing the 

appropriate option from the Tools menu of the Statement window. 
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Batch Producing Statement of Accounts 
In your statement production, you will come across times when you will need to print 
a whole batch of statements of accounts in one go. A typical application area of this is 
at the end of each term. To avoid the cumbersome task of loading each statement and 
printing it in turn, the levy system provided you with a convenient facility for 
producing an entire batch of statements of accounts in one go. This facility if provided 
from the window shown below that you can access by choosing Batch Print 
Statements of Accounts from the Deposits menu. 

 
 
To print an entire batch of statements of accounts, 

6. Select the start date for each statement. 
7. Select the end date of each statement 
8. Specify the balance types you would like to print. For example, if you only 

want to send statements to those whose caution deposit balance is below their 
minimum balance, select the “Accrued” option. 

9. Select the classes for which you would like to generate the statements. To do 
this, select the class you want to move from one of the lists to the other and 
then press the arrow with the same direction as the intended move. The arrows 
with the ‘As’ above them move all the items from one of the lists to the other. 

10. Select Print. 
 

 

Clicking the print button more than once will result in the Levy System 
printing multiple copies of each statement. Therefore, if your machine is 
a bit slow and the system appears not be responding, give it about 10 
seconds before clicking the button again. 
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Chapter 7: Balance Analysis 
 
There will be times when you will want a quick summary of the fees charged over a 
given period under a given fee name or a list of all the students in arrears. The Levy 
System has been designed with anticipation for this and you will find functions for 
performing such tasks under the Balances menu shown below. 

 
 

Fee Class Analysis 
The fee class analysis window is accessible from the Balances menu by choosing Fee 
Class Analysis. After doing this, you will be presented with the following window. 

 
 
 To obtain the balance analysis,  
¾ Specify a start and end date. 
¾ Choose the Analyse button 
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The summary will contain the following details 
¾ Deposit Analysis  

¾ Current shortfall 
¾ Current excess 
¾ Current net excess or shortfall 
¾ Current total credits 
¾ Current total debits 
¾ Current Total Minimum Balances 
¾ Duration Credits 
¾ Duration Debits 

¾ Levy Payments  
¾ Total payments over period 
¾ Current Accruals 
¾ Current Prepayments 

¾ Levy Fees Charged For each fee and total fees charged 
 
Once the summary has been loaded, you can then export or print it by choosing the 
appropriate function from the Tools menu. 
 

Student Levy Balance Analysis 
The window for this facility, shown below, is accessible from the Balances menu after 
choosing Student Levy Balances. This window gives you a summary of students 
with given balance types from given classes. 

 
 
To perform the analysis, 
1. Specify the Balance Type from the options provided. For example to view 

accrued balances only, select the Accrued option. 
2. Select the classes that you would like to include in the analysis. 
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3. Select the Analyse button. 
4. Optionally, print or export the data by choosing the appropriate function from the 

Tools menu. Note that you can also export the SQL used to generate the analysis. 
 
 

 

Use the Export SQL function as a basis for your Mail Merge jobs that 
are explained in the next chapter. You can refine the criteria for your 
analysis until it matches the students you would like to send mail to. 
You can also use the window to generate a list of all the students in a 
given set of classes by selecting “All” option and balance types. 

 

Student Deposit Balances 
The window for this facility, shown below, is accessible from the Balances menu after 
choosing Student Deposit Balances. This window gives you a summary of students 
with given balance types from given classes relative to their expected minimum 
balances. 

 
 
To perform the analysis, 
1. Specify the Balance Type from the options provided. For example to obtain a list 

of students whose deposit balances have fallen below the minimums set for their 
classes, select the Shortfall option. 

2. Select the classes that you would like to include in the analysis. 
3. Select the Analyse button. 
4. Optionally, print or export the data by choosing the appropriate function from the 

Tools menu. Note that you can also export the SQL used to generate the analysis.
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Chapter 8: Mail Merge 
 
The Mail Merge facility allows you to write a standard letter from which the system 
can then generate personalised letters using a query that you specify. When you start 
Mail Merge, you will be prompted for a Query Source File. This is the file that the 
system uses to obtain the personalised details. There are three possible sources for 
these files namely, 
¾ The SQL files that come with the system and are stored in the SQL folder. 
¾ SQL files that you will have written and saved yourself using the Advanced 

Search utility 
¾ SQL files that you will have created by exporting the Source SQL for searches 

and balance analysis. 
 
Before supplying a query file, it is often prudent for you to open it using the 
Advanced Search utility so that you can be assured that it returns the records that you 
want. Once you have specified the source query file, you will be presented with the 
following window. 

 
 
The above window is a typical document editor with added features for mail merge 
processing. You will find that you will be able to perform most of the functions you 
will need by selecting the toolbar buttons. To find out what a particular toolbar button 
does, place the mouse pointer over it for about 3 seconds and you will get a tool tip. 
 

Text Editing Functions 
After you have specified the source SQL file, you must then supply a document 
giving the standard letter. To do this, you can either type a new letter or open an 
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existing one which you can modify, if you wish, before you run the mail merge. The 
editor supports several file handling and document formatting functions. To get a feel 
of what a standard letter looks like, have a look at the sample provided in your 
Letters folder that is also reproduced below. 

 
 

Creating A New Document 
When you start the Mail Merge utility, it automatically loads a new document for you. 
If during your mail merge job you decide to create another document that will use the 
same SQL file, choose the ‘New’ icon in the document toolbar.  
 
To create a new document that will use a different SQL source file, use the Start 
New Session option outlined below instead. 

Opening A File 
1. Click the Open icon in the toolbar.  
2. Locate the file in the window provided and double click it. If you come across 

anything in this window that you do not understand, you can get additional help 
by clicking the What’s This icon shown in the diagram below and then clicking 
the item you want to find more information about. 
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Saving A File 
1. Click the Save icon.  
2. If the file does not have a filename, you will be prompted to specify a filename. If 

you need more information on any of the items in the windows that will be 
displayed, click the “What’s This” help button and then click the item you want 
additional information on. 

 

Saving A File Under A Different Filename 
If you wish to save the changes you will have made to the existing file but still want 
to keep the old version, you must save the displayed file under a different filename. 
To do this, 
1. From the File menu, choose “Save As”. 
2. You will be prompted to specify a filename. If you need more information on any 

of the items in the windows that will be displayed, click the “What’s This” help 
button and then click the item you want additional information on. 

Printing the Standard Letter 
1. Click the Print icon.  
2. A standard Print window from which you should choose the Print button will then 

prompt you. If you need more information on any of the items in the windows that 
will be displayed, click the “What’s This” help button and then click the item you 
want additional information on. 

Searching For Words or Phrases 
There will be times when you will want to locate a particular word or phrase from 
your standard letter. Steps for doing this are outlined below. 
1. Choose the New Search icon  
2. You will be resented with the following window. 

 
3. In the Find What box, enter the text you want to locate. 
4. Select the Whole Word option if you would like to find whole word only. 
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5. Select the Match Case option if you would like the matches to be only returned if 
they match the word you specified in terms of capitalisation. 

6. Select Find Next to locate the first match. 
7. To find additional matches either 

a. Choose the Find Next button. 
Or 

b. Close the Find window by selecting Cancel and then press the click the 
Find Next icon  

 
To start a new search, repeat the above steps. If the Find window is already open, 
simply type in the new word you want to look up and then choose the Find Next 
button. 
 

Replacing Words or Phrases 
1. Select Search and Replace from the Edit menu. 
2. You will be presented with the following window. 

 
3. In the Find What box, enter the text you want to replace. 
4. In the Replace With box, enter the text you would like to replace the text you will 

have specified above. 
5. Select the Whole Word option if you would like to find whole word only. 
6. Select the Match Case option if you would like the matches to be only returned if 

they match the word you specified in terms of capitalisation. 
7. If you want to replace all the occurrences in just “one go” then select the Replace 

All button. To replace items one by one, 
a. Click the Replace button. If a match is currently selected, the system will 

replace that single occurrence. If there is no match selected, the system 
will find the next match, select it and replace it the next time you click the 
Replace button 

b. If you come across an occurrence that you would like to skip over without 
replacing, select Find Next when it is selected. 

c. You can stop replacements at any time by choosing the cancel button. 

Cutting, Copying and Pasting 
The Levy system provided standard cut, copy and paste functions for text.  
¾ To copy some text, select the text and then select the copy icon from the 

toolbar . The keyboard shortcut is Ctrl⊕ C. 
¾ To cut some text, select the text and then select the cut icon from the toolbar 

. The keyboard shortcut is Ctrl⊕ X. 



41
 

¾ To paste some text, place the cursor where you want the text to be inserted and 
then select the paste icon from the toolbar.  The keyboard shortcut is 
Ctrl⊕V. 

These functions may work with pictures but this is not guaranteed. To get reliable 
results with pictures, use the keyboard shortcuts instead. 
 

Dealing with Fonts 
The document formatting used in the mail merge facility supports several fonts, font 
sizes and text effects like colour and underlining. To use these formatting facilities, 
1. Select the Fonts icon.  
2. You will be presented with the following window. 

 
3. Select the options you want. Note that the window your  operating system presents 

to you may look a bit different. 
4. Choose OK. 
 
Alternatively, you can use the toolbar formatting functions. To find out what each 
does, place your mouse over its icon for about 3 seconds. 
 

Changing Case 
You can change any selection of text to all capitals or small letters. To convert a 
selection into all capitals, select the capitalise  icon. For the reverse, use the “To 
Lower Case”  option. 

Inserting a Date Into Your Document 
1. Place the cursor where you want the date to be inserted. 
2. Select the Insert Date icon.  
3. You will be presented with following window. Double click the date you wish to 

include. To insert a date not displayed in the calendar, use the buttons in the top 
left and right corners to browse to the calendar for the year you want. 
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Inserting A Picture Into Your Document 
1. Place the cursor where you would like the picture to be inserted. 
2. Select Picture from the Insert menu. 
3. Select the picture file you would like to insert from the list of files provided. 
 

Inserting Another Document File Into Your Current Document 
1. Place the cursor where you would like the picture to be inserted. 
2. Select File from the Insert menu. 
3. Select the file you would like to insert from the list of files provided. 
 

Mail Merge Functions 

Merge Fields 
A merge field is a label instructing the system to insert a personalised detail at the 
position in the document at which the merge field is. For example, in the sample letter 
show at the beginning of this chapter there is a merge field for the address represented 
by «Guardian Address». This label is in fact an instruction to the system to replace 
«Guardian Address» with the contents of the “Guardian Address” column in the result 
of the query specified in the source SQL file that you supply when you are starting a 
merge session. To insert a merge field, 

1. Place the cursor where you would like the personalized detail to be inserted 
2. Do one of the following 

a. Click the insert merge field icon  and select the field you want from 
the list that will be provided from a window looking like the one 
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shown below. You select by either double clicking the field in the list 
or clicking the field and then the OK button. 

 
 

b. Press the right button of your mouse. You will be presented with a pop 
up menu from which you can then select the field you want 

 
c. Select Insert Field from the Mail Merge menu and follow the steps 

outlined under the first option. 

Previewing The Personalised Letters 
Before printing the personalised letters, you may want to have a look at how they will 
appear. To do this, choose the Preview Mail Merge  icon from the toolbar. This will 
display a window with a list of all the letters with the personalised details inserted. A 
sample of the window is shown below 
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Producing Personalised Letters 
To produce your personalised letters, simply choose the Produce Personalised 
Letters  icon. You will be shown a progress bar as the letters are produced. If the 
source query is complex, the system might take a little while before displaying the 
progress bar. Please be patient. 
 

Viewing The Query Source 
If for some reason you want to see what the source query you just specified contain, 
choose View Query Source from the Mail Merge option. This maybe particularly 
useful when the system presents you with a list of field names that you did not expect. 
 

Starting A New Session 
A mail merge session is based on a single SQL file. If at any point you decide that 
you want to use a different SQL file, you must start a new Session. To do this, choose 
“New Session” from the Mail Merge menu. 
 


